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6 Product Pillars
to meet your every need

Individually outstanding, unrivalled in combination

With our innovative, patented technologies, we make signal conditioning smarter and simpler. Our portfolio is composed of six
product areas, where we offer a wide range of analog and digital devices covering over a thousand applications in industrial
and factory automation. All our products comply with or surpass the highest industry standards, ensuring reliability in even
the harshest of environments and have a 5-year warranty for greater peace of mind.
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Our range of temperature transmitters and sensors provides the highest level of signal integrity from the
measurement point to your control system. You can convert industrial process temperature signals to analog, bus or
digital communications using a highly reliable point-to-point solution with a fast response time, automatic self-
calibration, sensor error detection, low drift, and top EMC performance in any environment.

We deliver the safest signals by validating our products against the toughest safety standards. Through our
commitment to innovation, we have made pioneering achievements in developing |.S. interfaces with SIL 2 Full
Assessment that are both efficient and cost-effective. Our comprehensive range of analog and digital intrinsically
safe isolation barriers offers multifunctional inputs and outputs, making PR an easy-to-implement site standard.
Our backplanes further simplify large installations and provide seamless integration to standard DCS systems.

We provide inexpensive, easy-to-use, future-ready communication interfaces that can access your PR installed base
of products. All the interfaces are detachable, have a built-in display for readout of process values and diagnostics,
and can be configured via push-buttons. Product specific functionality includes communication via Modbus and
Bluetooth and remote access using our PR Process Supervisor (PPS) application, available for iOS and Android.

Our unique range of single devices covering multiple applications is easily deployable as your site standard. Having
one variant that applies to a broad range of applications can reduce your installation time and training, and greatly
simplify spare parts management at your facilities. Our devices are designed for long-term signal accuracy, low
power consumption, immunity to electrical noise and simple programming.

Our compact, fast, high-quality 6 mm isolators are based on microprocessor technology to provide exceptional
performance and EMC-immunity for dedicated applications at a very low total cost of ownership. They can be
stacked both vertically and horizontally with no air gap separation between units required.

Our display range is characterized by its flexibility and stability. The devices meet nearly every demand for display
readout of process signals and have universal input and power supply capabilities. They provide a real-time
measurement of your process value no matter the industry and are engineered to provide a user-friendly and reliable
relay of information, even in demanding environments.
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2-wire level transmitter

5343

Potentiometer or Ohmic input
Programmable sensor error value
High measurement accuracy
Unique process calibration function
Programmable via standard PC

Application

Conversion of resistance variation to standard analog
current signals, e.g. from Ohmic level sensors or valve
positions.

User-defined linearization function can be activated.

Technical characteristics

Within a few seconds the user can program PR5343 to
measure within the defined Ohmic values.

Continuous check of vital stored data for safety reasons.
The transmitter is protected against polarity reversal.
PR5343 is configured to the current task by way of a PC,
the PRelevel software and the communications interface
Loop Link.

The PRelevel configuration tool included in the PReset
software has been developed specifically for the
configuration of level applications. Among other things, it
contains a function for "on line” measurement of input
span as well as a linearization function for volume linear
output from horizontal cylindrical tanks.

Mounting / installation

For DIN form B sensor head mounting. In non-hazardous
areas the 5343 can be mounted on a DIN rail with a special
fitting.

Applications

Z2-wire installation
in control room

Ohmic level sensor
t04..20 mA

Z2-wire installation

Potentiometer in control room

t04..20 mA

2-wire installation

Resistance to 4..20 mA in control room

5343V112-UK



Order

Type Version

5343 |Zone 2 /Div.2 :
Zone0,1,2,21,22,M1/DIV.1,DIV.2 ‘B

Electrical specifications

Environmental conditions:

Operating temperature . . . . . . . . oo -40°C to +85°C
Calibration temperature. . . . . . . . . ... . 20...28°C
Humidity. . . . . < 95% RH (non-cond.)
Protection degree, enclosure / terminals. . . . ... ............... IP68 / IPOO
Mechanical specifications:
DIMeNnsions . . . . . @44 x 20.2 mm
Weight. . . . . 50¢g
MaX. WIre Size. . . . . o oo 1 x1.5 mm? stranded wire
Screw terminal torque. . . . . . . .. e 0.4 Nm
Vibration. . . . . . IEC60068-2-6
2.25Hz. +1.6 mm
25.100Hz. . ... t4g
Common specifications:
Supply voltage, DC
5343 A, 8.0..35 VDC
5343B. . 8.0..30 VDC
Internal power dissipation
5343 A, 25 mW..0.8 W
5343B. . 25 mW..0.7 W
Voltage drop . . . . . . 8.0 VDC
Warm-up time. . . . . .. 5 min.
Programming . . . . . . . . Loop Link
Signal/noiseratio. . . .. ... .. . > 60dB
Response time (programmable) . . . . ... ... ... . . . oL 0.33..60s
Signal dynamics, input . . . . ... 19 bit
Signal dynamics, output . . . . ... 16 bit
Effect of supply voltage variation. . . . . ......... ... .. ... . .... < 0.005% of span / VDC

Accuracy, the greater of general and basic values:

General values

Input type Absolute accuracy Temperature coefficient

Lin.R < +0.1% of span < +#0.01% of span/°C

Basic values

Input type Basic accuracy Temperature coefficient
Lin.R <+0.05Q <+0.002 Q/°C
EMC - immunity influence. . . . . ... ... ... .. ... . < +0.5% of span

5343V112-UK



Electrical specifications, input:
Linear resistance input:

Measurement raNge . & .« . v v v e 0..100kQ

Min. measurement range (SPan). . . . . v v 1kQ

Max. offset . . . . .. 50% of selec. max. value
Cableresistance perwire (Max.). . . . . . v v vttt 100Q

SeNSOr CUMENT . . . v o o >25pA, <120 pA

Effect of sensor cable resistance (3-wire) . . . . ... ... ... .. <0.0020Q/Q

Sensor errordetection . . .. . ... Yes

Output:

Current output:

Signalrange. . . . . . . . e 4..20 mA
Min.signalrange. . . . . ... . .. . 16 mA

Updatingtime . . ... ... .. . . . . . . 135 ms

Load resistance. . . . . . . o < (Vsupply - 8.0) /0.023 [Q]
Loadstability. . . . . . .. . < +0.01% of span /100 Q
Sensor error detection:

Programmable . . . . . . . . 3.5.23 mA

Namur NE43 Upscale . . . . . . . o 23 mA

Namur NE43 Downscale . . . . . ... 3.5mA

Of span = Of the presently selected range

Observed authority requirements:

EMC. . 2014/30/eU & UK SI1 2016/1091
ATEX . 2014/34/eU & UK SI 2016/1107
ROHS . . 2011/65/€EU & UK SI1 2012/3032
BAC. . . TR-CU 020/2011
BACEX . . o oo TR-CU 012/2011
Marine approval:
DNV-GL, Ships & Offshore . . ... .. ... ... . ... . . . .. .. TAA0000101
Ex /LS. approvals:
5343A;
ATEX . DEKRA 20ATEX0106X
5343B
ATEX . DEKRA 20ATEX0105X
FM FM17US0013X
5343A & 5343B:
ECEX. . o v DEK 20.0062X
INMETRO . . . o DEKRA 23.0010X
BACEX. « o v EAEU KZ 7500361.01.01.08756
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Potentiometer,
3-wire

Connections

Input:

Resistance, 2-wire

Resistance, 3-wire
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2-wire installation
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Programming

e Loop Link is a communications interface that is needed for programming 5343.
e For programming please refer to the drawing below and the help functions in PReset.
e Loop link is not approved for communication with modules installed in harzardous (Ex) areas.

Receiving
Disconnect equipment
A r o "Vsupply
Red , * Yellow
o / . Input

/
, =Green

Connector

Loop Link

5909 - USB

*Connectedonly for
‘on-line” programming

Mechanical specifications Mounting of sensor wires

Wires must be mounted
between the metal plates.

|2 A I SN B AN B B

33 mm 20.2 mm

@44 mm
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Configuration of potentiometer input

In an Ohmic level sensor the resistance value changes when a magnetic floater activates the reed contacts in the sensor. This
means that it is usually not possible to make use of the entire level sensor as input span. When PR5343 is used with a
potentiometer input, the PRelevel software contains the following special functions for configuration:

[Calibration Password] is 4711. This password should be entered at program start. The only parameters which can be
changed without entering this password are Input Low and High for the potentiometer input. The menu item is located under
Tools > Options.

Please pay special attention to the text in the ‘Information’ window during transmission. When the configuration cannot be
sent to the transmitter due to lack of password, the following text will appear: ‘Operation aborted.’ 'Configuration NOT
transmitted to the device.

The following description of configuration with potentiometer input is based on figure 1. Please note that the PRelevel
software only comes in an English-language version. Therefore the menu texts are represented here as they are seen on the
screen. First choose the [Input] tab:

A % of tank height % of level sensor

A
100

100

90 T 1lgo

60 | I'so
50 | [so
0! e

Input in % of height

T + 30
30 1 i
- + 20
20 1 1
+ 10

«——— Electrical Calibration

«—— Placement Calibration

10 +

~——— 0

Figure 1, cross section of horizontal cylindrical tank

[Electrical Calibration] Enter the range to be detected by the connected potentiometer or let PRelevel measure the available
range. The transmitter must be connected to the communications interface before the values can be measured.
The values in figure 1 are Low = 3% og High = 97%.

[Placement Calibration] Enter the placement of the ‘Electrical Calibration’ Low and High points of the level sensor in relation
to the height of the tank. These values are used for calculation of linearization values and for calculation of 0 and 100%
height.

The values in figure 1 are Low = 9% and High = 94%.

[Input] Enter the desired input span in relation to the height. When input Low and High are selected as 0 and 100%, the input
can never go below 9% and above 94% due to the design and mounting of the level sensor. If the output spanis 4...20 mA,
the output will only vary between 5.44...19.04 mA.

The values in figure 1 are Low = 0% and High = 100%.

5343V112-UK 9



Activation of embedded linearisations

The PRelevel software contains embedded linearization functions for horizontal cylindrical tanks and spherical tanks. The
linearization functions can be activated as follows:

Custom input type: In order to gain access to a customer-defined linearization, the selection in the [General Type] input box
must end with the text ‘Custom’ and the [Calibration Password] 4711 must be entered.

Activation of linearization: Choose the [Options] tab in the PRelevel 5343 window. If one of the embedded linearizations is
to be used, the selection in the ‘Linearization’ window must be ‘Polynomial.....(Relative)' in order to retrieve the most accurate
linearization files. The files are retrieved by way of the following menus: >Specify + select >File > Open in the main menu +
select >File name >Open in the file dialogue box.

User-defined linearization: It is possible to enter specific linearization tables in the >Specify menu.

10 5343V112-UK



ATEX-installation drawing 5343QA02-V3R0

For safe installation of 534 3A the following must be observed. The module
shall only be installed by qualified personnel who are familiar with the national
and international laws, directives and standards that apply to this area. Year of
manufacture can be taken from the first two digits in the serial number.

ATEX Certificate DEKRA 20ATEX0106 X
Marking 3G ExnAJic]ICT6... T4 Gc
@ I 3G Exec[ic] ICT6 ... T4 G

N3GExicllCT6...T4 Ge

13D ExicllIC Dc
Standards EN 60079-0: 2018, EN 60079-11: 2012,

EN 60079-15: 2010, EN 60079-7:2015 +A1: 2018
Terminal 3,4,6 Terminal 1,2 Terminal 1,2 Terminal 1,2
Exic lIC,Exic llIC Exic lIC,Exic llIC | Exic lIC,Exic llIC | Ex nA, Ex ec
Uo: 5V Ui=35V Ui=24V Umax < 35 VDC
lo: 4.0 mA li=110 mA li =260 mA ,
Po: 20 mW Ci=1nF Ci=1nF °
Lo: 900 mH Li=10 puH Li=10 pH Umax <24 VDC
Co: 1000 uF

Ex ic lIC, Exic lliIC

Ambient temperature range

Temperature
Class Ui=35V Ui=24 V
T6 -40°C to +54°C -40°C to +63°C
T5 -40°C to +69°C -40°C to +78°C
T4 -40°C to +85°C -40°C to +85°C
Ex ec, Ex nA Ambient temperature range
Temperature
Class Vmax=35V Vmax=24 V
T6 -40°C to +43°C -40°C to +55°C
T5 -40°C to +85°C -40°C to +85°C
T4 -40°C to +85°C -40°C to +85°C

5343V112-UK
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Installation notes

If the enclosure is made of non-metallic plastic materials, electrostatic
charges on the transmitter enclosure shall be avoided.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gc and applied in type of protection Ex ic, the
transmitter shall be mounted in an enclosure that provides a degree of
protection of at least IP20 according to EN 60529, and that is suitable for the
application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Dc, the transmitter shall be mounted in a
separately certified enclosure that provides a degree of protection of at least
IP5X according to EN 60079-0, and that is suitable for the application and
correctly installed. The surface temperature of the outer enclosure is +20 K
above the ambient temperature, determined without a dust layer.

Ambient temperature range: -40°C to +85°C.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gc and applied in type of protection Ex nA or Ex
ec, the transmitter shall be mounted in a separately certified enclosure that
provides a degree of protection of at least IP54 according to EN 60079-0,
and that is suitable for the application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gc and applied in type of protection Ex nA or Ex
ec, the equipment shall only be used in an area of not more than pollution
degree 2, as defined in EN 60664-1.

5343V112-UK



ATEX-installation drawing 5343QA01-V3R0

For safe installation of 5343B the following must be observed. The
module shall only be installed by qualified personnel who are
familiar with the national and international laws, directives and
standards that apply to this area. Year of manufacture can be taken
from the first two digits in the serial number.

ATEX Certificate DEKRA 20ATEX0105 X

Marking 11 G Exia lIC T6..T4 Ga
@ 112D ExialllC Db
| M1 Exial Ma
Standards EN 60079-0: 2018, EN 60079-11: 2012
Hazardous area
Zone 0, 1,2, 21, 22 Non Hazardous Area
Terminal: 3,4,6 —16
Uo: 30 VDC N
lo: 8 mA 3 1
Po: 60 mW -
Lo: 35 mH — 2
Co: 66 nF —13
5343B
Barrier

Terminal: 1,2
Ui: 30 VDC |
li: 120 mA

Pi: 0.84 Wor0.75W

Li: 10 uH

Ci: 1.0 nF

5343V112-UK
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Temperature Ambient temperature range
Class Pi: 0.84 W Pi: 0.75 W
T6 -40°C to +47°C -40°C to +50°C
T5 -40°C to +62°C -40°C to +65°C
T4 -40°C to +85°C -40°C to +85°C

Installation notes

If the enclosure is made of non-metallic plastic materials, electrostatic
charges on the transmitter enclosure shall be avoided.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ga, the transmitter shall be mounted in an
enclosure that provides a degree of protection of at least IP20 according to
EN 60529, and that is suitable for the application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ga or Ma, and if the enclosure is made of
aluminum, it must be installed such, that ignition sources due to impact and
friction sparks are excluded.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Db, the transmitter shall be mounted in a
separately certified enclosure that provides a degree of protection of at least
IP5X according to EN 60079-0, and that is suitable for the application and
correctly installed. The surface temperature of the outer enclosure is +20 K
above the ambient temperature, determined without a dust layer.

Ambient temperature range: -40°C to +85°C.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ma, the transmitter shall be mounted in an
enclosure that provides a degree of protection of at least IP54 according to
EN 60529, and that is suitable for the application and correctly installed.
Ambient temperature range: -40°C to +85°C.

Cable entries and blanking elements shall be used that are suitable for the
application and correctly installed.

For an ambient temperature = 60°C, heat resistant cables shall be used with
a rating of at least 20 K above the ambient temperature.

5343V112-UK



IECEXx-installation drawing 5343Ql02-V3R0

For safe installation of 534 3A the following must be observed. The module
shall only be installed by qualified personnel who are familiar with the national
and international laws, directives and standards that apply to this area. Year of
manufacture can be taken from the first two digits in the serial number.

Certificate

Marking

Standards

IECEx DEK 20.0062X

ExnAlic] ICT6 ... T4 Gc
Execlic]ICT6 ... T4 Gc

ExicllCT6 ... T4 Gc

Ex ic IlIC Dc

IEC 60079-0: 2017, IEC 60079-11: 2011,
IEC 60079-15: 2010, IEC 60079-7:2017

Terminal 3,4,5,6 Terminal 1,2 Terminal 1,2 Terminal 1,2

Ex ic IIC,Exic llIC Exic lIC,Exic llIC | ExiclIC,Exic llIC | Ex nA, Ex ec
Uo:5V Ui=35V Ui=24V Umax <35 VDC
lo: 4 mA li=110 mA li =260 mA

Po: 20 mW Ci=1nF Ci=1nF or

Lo: 900 mH Li=10 uH Li=10 uH Umax <24 VDC
Co: 1000 uF

Ex ic lIC, ExiclliIC

Ambient temperature range

Temcﬁggure Ui=35V Ui=24V
T6 -40°C to +54°C -40°C to +63°C
T5 -40°C to +69°C -40°C to +78°C
T4 -40°C to +85°C -40°C to +85°C

Ex ec, Ex nA

Ambient temperature range

Temcpizgastu * Vmax=35V Vmax=24 V
T6 -40°C to +43°C -40°C to +55°C
T5 -40°C to +85°C -40°C to +85°C
T4 -40°C to +85°C -40°C to +85°C

5343V112-UK
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Installation notes

If the enclosure is made of non-metallic plastic materials, electrostatic
charges on the transmitter enclosure shall be avoided.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gc and applied in type of protection Ex ic, the
transmitter shall be mounted in an enclosure that provides a degree of
protection of at least IP20 according to IEC 60529, and that is suitable for the
application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Dc, the transmitter shall be mounted in a
separately certified enclosure that provides a degree of protection of at least
IP5X according to IEC 60079-0, and that is suitable for the application and
correctly installed. The surface temperature of the outer enclosure is +20 K
above the ambient temperature, determined without a dust layer.

Ambient temperature range: -40°C to +85°C.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gc and applied in type of protection Ex nA or Ex
ec, the transmitter shall be mounted in a separately certified enclosure that
provides a degree of protection of at least IP54 according to IEC 60079-0,
and that is suitable for the application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Gec and applied in type of protection Ex nA or Ex
ec, the equipment shall only be used in an area of not more than pollution
degree 2, as defined in IEC 60664-1.

5343V112-UK



IECEXx-installation drawing 5343QI01-V3R0

For safe installation of 5343B the following must be observed.

The module shall only be installed by qualified personnel who

are familiar with the national and international laws, directives

and standards that apply to this area. Year of manufacture can
be taken from the first two digits in the serial number.

Certificate IECEx DEK 20.0062X
Marking Exia lIC T6..T4 Ga
Ex ia IlIC Db
Exia |l Ma
Standards IEC 60079-0: 2017, IEC 60079-11: 2011

Hazardous area
Zone 0,1, 2,21, 22

Non Hazardous Area
Terminal: 3,4,6
Uo: 30 VDC =—6
lo: 8 mA +
Po: 60 mW 1
Lo: 35 mH -
Co: 66 nF 4 2
3 5343B
Barrier

Terminal: 1,2

Ui: 30 VDC

li: 120 mA

Pi: 0.84 W or0.75W |

Li: 10 yH

Ci: 1.0 nF

5343V112-UK
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Temperature Ambient temperature range
Class Pi: 0.84 W Pi: 0.75W
T6 -40°C to +47°C -40°C to +50°C
T5 -40°C to +62°C -40°C to +65°C
T4 -40°C to +85°C -40°C to +85°C

Installation notes

If the enclosure is made of non-metallic plastic materials, electrostatic charges
on the transmitter enclosure shall be avoided.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ga, the transmitter shall be mounted in an
enclosure that provides a degree of protection of at least IP20 according to
IEC 60529, and that is suitable for the application and correctly installed.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ga or Ma, and if the enclosure is made of
aluminum, it must be installed such, that ignition sources due to impact and
friction sparks are excluded.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Db, the transmitter shall be mounted in a separately
certified enclosure that provides a degree of protection of at least IP5X
according to IEC 60079-0, and that is suitable for the application and correctly
installed. The surface temperature of the outer enclosure is +20 K above the
ambient temperature, determined without a dust layer.

Ambient temperature range: -40°C to +85°C.

If the transmitter is installed in an explosive atmosphere requiring the use of
equipment protection level Ma, the transmitter shall be mounted in an
enclosure that provides a degree of protection of at least IP54 according to
IEC 60529, and that is suitable for the application and correctly installed.
Ambient temperature range: -40°C to +85°C.

Cable entries and blanking elements shall be used that are suitable for the
application and correctly installed.

For an ambient temperature = 60°C, heat resistant cables shall be used with a
rating of at least 20 K above the ambient temperature.

5343V112-UK
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FM Installation Drawing

Model 5331D, 5332D, 5333D and 5343B

Hazardous (Classified) Location

Class |,Division1, Groups, A,B,C,D T4..T6
Class |, Zone 0, AEx ia IIC T4..T6

Ambient temperature limits

Non Hazardous Location

T4:-40 to + 85 deg. Celcius
T6:-40 to + 60 deg. Celcius

Terminal 1, 2
Vmax or Ui: 30 V
Imax or li: 120 mA
Pmax or Pi: 0.84 W
Ci: 1 nF

Li:10 uH

SENSOR

Model 5335D, 5337D

Hazardous (Classified) Location

Class |,Division1, Groups, A,B,C,D T4..T6
Class |, Zone 0, AEx ia IIC T4..T6

Ambient temperature limits

Associated Apparatus
or Barrier
with
entity Parameters:

UM < 250V

Voc or Uo <Vmax or Ui
Iscorlo < Imaxorli
Po < Pi

Ca or Co > Ci + Ccable
Laor Lo > Li+ Lcable

This device must not be connected
to any associated apparatus which
uses or generates more than 250
VRMS

Non Hazardous Location

T4: -40 to + 85 deg. Celcius
T6: -40 to + 60 deg. Celcius

Terminal 1, 2
Vmax or Ui: 30 V
Imax or li: 120 mA
Pmax or Pi: 0.84 W
Ci: 1 nF

Li:10 uH

Terminal 3,4,5,6

Associated Apparatus
or Barrier
with
entity Parameters:

UM < 250V

Voc or Uo < Vmax or Ui
Iscorlo < Imaxorli
Po < Pi

Ca or Co > Ci + Ccable
LaorLo >Li+ Lcable

This device must not be connected

VtorUo: 9.6 V to any associated apparatus which
It or lo: 28 mA uses or generates more than 250
Pt or Po: 67.2 mW VRMS
Caor Co: 3.5 uF
LaorLo: 35 mH SENSOR
Revision date: Version Revision Page:
2020-03-30 V3R0 1/2
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The entity concept
The Transmitter must be installed according to National Electrical Code (ANSI-NFPA 70) and shall be
installed with the enclosure, mounting, and spacing segregation requirement of the ultimate application.

Equipment that is FM-approved for intrinsic safety may be connected to barriers based on the ENTITY

CONCEPT. This concept permits interconnection of approved transmitters, meters and other devices in
combinations which have not been specifically examined by FM, provided that the agency's criteria are
met. The combination is then intrinsically safe, if the entity concept is acceptable to the authority having
jurisdiction over the installation.

The entity concept criteria are as follows:

The intrinsically safe devices, other than barriers, must not be a source of power.

The maximum voltage Ui(Vmax) and current li(Iwax), and maximum power Pi(Pmax), which the device can
receive and remain intrinsically safe, must be equal to or greater than the voltage (Uo or Voc or Vt) and
current (lo or Isc or It) and the power Po which can be delivered by the barrier.

The sum of the maximum unprotected capacitance (Ci) for each intrinsically device and the interconnect-
ing wiring must be less than the capacitance (Ca) which can be safely connected to the barrier.

The sum of the maximum unprotected inductance (Li) for each intrinsically device and the interconnecting
wiring must be less than the inductance (La) which can be safely connected to the barrier.

The entity parameters Uo,Voc or Vi and lo,lsc or I, and Ca and La for barriers are provided by the barrier
manufacturer.

NI Field Circuit Parameters

Model 5331D, 5332D, 5333D, 5335D, 5337D and 5343B

Hazardous (Classified) Location . Non Hazardous Location
Class |,Division2, Groups, A,B,C,D T4..T6
Class |, Zone 2, IIC T4..T6 . Associated Apparatus
: or Barrier

Ambient temperature limits
T4: -40 to + 85 deg. Celcius
T6: -40 to + 60 deg. Celcius

Terminal 1, 2

Vmax: 35V
Ci: 1.0 nF
Li:10 uH
@
6 3 This device must not be connected
5 4 . to any associated apparatus which
¢ uses or generates more than 250
VRMS
| SENSOR I
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Desenho de Instalagao INMETRO

Para instalagdo segura do 5333A ou 5343A o seguinte deve ser observado. O modelo deve
apenas ser instalado por pessoas qualificadas que sao familiarizadas com as leis nacionais e
internacionais, diretrizes e padrées que se aplicam a esta area.

O ano de fabricagédo pode ser pego dos dois primeiros digitos do niumero de série.

Certificado DEKRA 23.0010 X
Marcas Ex ec [ic] IIC T6..T4 Gc
ExiclIC T6..T4 Gc
Ex ic llIC Dc
Normas ABNT NBR IEC 60079-0:2020 Versao Corrigida:2023

ABNT NBR IEC 60079-7:2018 Versao Corrigida:2022
ABNT NBR IEC 60079-11:2013 Versao Corrigida:2017

Terminais 3,4,5,6

Terminais 1,2

Terminais 1,2

Terminais 1,2

Exic lIC,Exic IlIC

Exic lIC,Exic IlIC

Exic lIC,Exic llIC | Exec

Uo: 5V Ui=35V Ui=24V Umax < 35 Vdc
lo: 4 mA li=110 mA li =260 mA ;
Po: 20 mW Ci=1nF Ci=1nF °
Lo: 900 mH Li=10 yH Li=10 uH Umax < 24 Vdc
Co: 1000 pyF
ExiclIC, Ex ic lliIC Faixa de temperatura ambienta
Classe de . .
temperatura Ui=35V Ui=24V
T6 -40 °C to +54 °C -40 °C to +63 °C
T5 -40 °C to +69 °C -40 °C to +78 °C
T4 -40 °C to +85 °C -40 °C to +85 °C
Ex ec Faixa de temperatura ambienta
Classe de
temperatura Umax=35V Umax=24V
T6 -40 °Cto +43 °C -40 °C to +55 °C
T5 -40 °C to +85 °C -40 °C to +85 °C
T4 -40 °C to +85 °C -40 °C to +85 °C
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Notas para instalagao

Se o involucro for feito de materiais plasticos ndo metalicos, devem ser evitadas cargas eletrostaticas
no involucro do transmissor.

Se o transmissor for instalado em uma atmosfera explosiva que exija o uso de nivel de protegéo de
equipamento Gc e aplicado no tipo de protegéo Ex ic, o transmissor devera ser montado em um
gabinete que fornega um grau de protecao de pelo menos IP20 de acordo com ABNT NBR IEC
60529, e adequado a aplicagao e instalado corretamente.

Se o transmissor for instalado em uma atmosfera explosiva que exija o uso de nivel de protegdo de
equipamento Dc, o transmissor devera ser montado em um involucro certificado separadamente que
forneca um grau de protecéo de pelo menos IP5X de acordo com a ABNT NBR IEC 60079-0, e que
seja adequado para o aplicativo e instalado corretamente. A temperatura da superficie do invélucro
externo é +20 K acima da temperatura ambiente, determinada sem camada de poeira.

Faixa de temperatura ambiente: -40 °C a +85 °C

Se o transmissor for instalado em uma atmosfera explosiva que exija o uso de nivel de protegdo de
equipamento Gc e aplicado no tipo de protegéo Ex ec, o transmissor devera ser montado em um
invélucro certificado separadamente que fornega um grau de protecao de pelo menos IP54 de acordo
com conforme ABNT NBR IEC 60079-0, e que seja adequado a aplicacéo e instalado corretamente.

Se o transmissor for instalado em uma atmosfera explosiva que exija o uso de nivel de protecédo de
equipamento Gc e aplicado no tipo de protegédo Ex ec, o equipamento devera ser usado somente em
uma area com grau de polui¢cdo nao superior a 2, conforme definido na IEC 60664-1.
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Desenho de Instalagao INMETRO

Para instalacdo segura do 5333D ou 5343B o seguinte deve ser observado. O modelo deve apenas
ser instalado por pessoas qualificadas que sao familiarizadas com as leis nacionais e
internacionais, diretrizes e padrées que se aplicam a esta area.

O ano de fabricagédo pode ser pego dos dois primeiros digitos do nimero de série.

Certificado DEKRA 23.0010 X
Marcas Exia IIC T6...T4 Ga
Exia llIC Da
Exia | Ma
Normas ABNT NBR IEC 60079-0:2020 Versio Corrigida:2023

ABNT NBR IEC 60079-11:2013 Versao Corrigida:2017

Areas classificadas
Zona 0, 1, 2, 20, 21, 22 Areas nao

| classificadas
T4: -40 < Ta <85°C
T5: -40 < Ta <60°C |
T6: -40 < Ta<45°C

Terminais: 6 |
3!45556 5 1|+_
Uo: 30 VDC |
lo: 8 mA —_—s 2=
PO.Z 60 mW 3 5333D |
Co: €6 nF | Barrier
Terminais: 1,2 |
Ui: 30 VDC |
li: 120 mA
Pi: 0,84 W |
Li: 10 uH
Ci: 1,0nF
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Notas de Instalagao.

Em uma atmosfera de gas potencialmente explosiva, o transmissor deve ser montado em um
invélucro a fim de garantir no minimo um grau de protegéo IP20 de acordo com ABNT NBR
IEC60529. Se contudo o ambiente necessitar um nivel de protecdo maior, isso deve ser
levado em consideracéo.

Se o transmissor € instalado em uma atmosfera explosiva exigindo o uso de equipamento de
protecao de nivel Ga, Ma e Mb, e se o invoélucro for feito de aluminio, ele deve ser instalado de
modo que, mesmo em caso de avaria remota, fontes de ignigao devido a impacto e fricgao,
faiscas séo eliminadas; Se o invélucro é feito de materiais ndo metalicos, cargas
eletroestaticas devem ser evitadas.

Se o involucro é feito de materiais nao metalicos, cargas eletroestaticas devem ser evitadas.

Para instalagdo em atmosfera de poeira potencialmente explosiva, as instru¢gdes a seguir sdo
aplicaveis:

O transmissor deve ser montado em involucro de metal forma B de acordo com DIN43729 que
esta fornecendo pelo menos um grau de protegéo IP6X de acordo com ABNT NBR IEC60529.
O involucro deve ser adequado para aplicagéo pretendida e instalado corretamente.

As entradas dos cabos e os elementos de obturagdo que podem ser utilizados devem ser
adequados a aplicagéo pretendida e corretamente instalados.

Para temperatura ambiente >= 60°C, fios de resisténcia ao calor devem ser usados com uma
faixa de pelo menos 20K acima da temperatura ambiente.
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Document history

The following list provides notes concerning revisions of this document.

Rev. ID Date Notes

104 1414 IECEX, FM and INMETRO approvals added.

105 1503 GL marine approval added.

106 1707 IECEX, FM and INMETRO installation drawings updated.

107 1848 FM installation drawing updated.

108 2004 INMETRO installation drawing updated.

109 2139 ATEX and IECEx approvals updated - Ex na changed to Ex ec.
110 2245 UKCA added.

111 2345 INMETRO approval updated - Ex nA replaced by Ex ec.

112 2507 New EAC Ex certificate.
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We are near you,

all over the world

Our trusted red boxes are supported wherever you are

All our devices are backed by expert service and a 5-year
warranty. With each product you purchase, you receive
personal technical support and guidance, day-to-day
delivery, repair without charge within the warranty period
and easily accessible documentation.

We are headquartered in Denmark, and have offices and
authorized partners the world over. We are a local

business with a global reach. This means that we are
always nearby and know your local markets well.

We are committed to your satisfaction and provide
PERFORMANCE MADE SMARTER all around the world.

For more information on our warranty program, or to meet
with a sales representative in your region, visit
prelectronics.com.




Benefit today from
PERFORMANCE MADE SMARTER

PR electronics is the leading technology company specialized in making industrial process
control safer, more reliable and more efficient. Since 1974, we have been dedicated to
perfecting our core competence of innovating high precision technology with low power
consumption. This dedication continues to set new standards for products communicating,
monitoring and connecting our customers’ process measurement points to their process
control systems.

Our innovative, patented technologies are derived from our extensive R&D facilities and
from having a great understanding of our customers’ needs and processes. We are guided
by principles of simplicity, focus, courage and excellence, enabling some of the world’s
greatest companies to achieve PERFORMANCE MADE SMARTER.

www.prelectronics.com



	Application
	Technical characteristics
	Mounting / installation
	Applications
	Order
	Electrical specifications
	Connections
	Block diagram
	Programming
	Mechanical specifications
	Mounting of sensor wires
	Configuration of potentiometer input
	Activation of embedded linearisations
	ATEX Installation Drawing - 5343A
	ATEX Installation Drawing - 5343B
	IECEx Installation Drawing - 5343A
	IECEx Installation Drawing - 5343B
	FM Installation Drawing - 5343B
	INMETRO Installation Drawing - 5343A
	INMETRO Installation Drawing - 5343B
	Document history

